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This document is designed to provides a guide to installing, setting up and testing PaperCut for use with an ACDI EX 

Series payment device (EX2000series, ACD3000Series, TheSwiper). Setup and testing should take around 30 minutes. No 

system level restart is required;  
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Print Queue and Admin Configuration 

This section describes various preparatory steps within PaperCut before implementing a Release Station.   

Enabling hold/release support on a printer 
By default, print jobs will be sent directly to the printer and will not be held. To turn on hold/release support on a given 

printer: 

1. Log on to the administration section. 

2. Navigate to the Printers section. 

3. Select the printer. 

4. Select the option to Enable hold/release queue. 

5. Choose the appropriate release mode for your needs. 

The two release modes available are: 

 User Release - this is the standard mode that allows users to release and view only the jobs printed under their 

name/user account. 

 Admin/Manager only release - in this mode, jobs can only be released by administrators or hold/release queue 

managers. 

Tip 

To configure multiple printers with a hold/release queue support, the Copy settings to other printers function can be 

used. To use this, configure one printer as required, press the Copy settings to other printers and select the printers to 

copy the settings to. 

Hold/Release Queue Managers 
A hold/release queue manager is a user that has additional privileges to manage release stations and jobs held in hold 

release queues. Managers can: 

 Log on to the "manager mode" release stations (both the software and web-based release station). 

 Log on to the "secure mode" release stations which switches them into manager mode so that users' print jobs 

can be released. 

 Release jobs that can only be released by managers or administrators. 

 Can close the Standard Release Station when running in full-screen mode. 

 Use the Override Print Account selection in the web-based release station. 

To make a user or group a hold/release queue manager: 

1. Log on to the administration pages. 

2. Navigate to the Options → Admin Rights. 
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3. Add a user or group as an administrator. 

4. To restrict their access to only the release station interface and deselect all the other admin rights. 

5. Click on the Apply button to save the changes. 

To get more information about assigning admin rights see the section called “Assigning Administrator Level Access”. 

It is also possible to make a user a hold/release queue manager by following the steps below: 

1. Log on to the administration pages. 

2. Navigate to the Options section. 

3. Find the Release Station security section. 

4. Enter user's username in Hold/Release Queue Managers field. To enter multiple users, separate usernames with 

a comma (,). 

Standard Release Station Deployment 

The Standard Release Station is configured using a configuration file located in the directory where the release station 
executables are located. The default configuration file is:  “[app-path]\release\config.properties”.  This configuration file 
allows you to configure the behavior and look of the release station in a number of ways. Each of the configuration items 
are described in the table below: 

Config name Description 

mode The mode changes the behavior of the release station depending on the need. The available 
modes are described in the section called “Release Station Modes”. 

use-username-
authentication 

(Y/N) - Enable username authentication. Users will be required to enter their domain username 
to log into the release station. They may also be required to enter their password, depending on 
the 'mode' setting. Default: Y (Yes). 

use-card-
authentication 

(Y/N/USERNAME) - Enable card-based authentication. This is designed for use with dedicated 
hardware card readers. 

If Y: The card number is validated against the user's card-number field. 

If USERNAME: The card value is interpreted as a username. The user will be prompted for a 
password if required. 

Default: N (No). 

show-jobs-from-
queues 

Filters the list of jobs to only those print queues listed. This is a comma separated list of full 
printer names (i.e. server\printer). This is useful when there are multiple release stations, each 
managing the queues of a different set of printers. 

http://www.papercut.com/products/ng/manual/ch-sys-mgmt-admin-access.html
http://www.papercut.com/products/ng/manual/rs-conf.html#rs-conf-software-modes


Setup  of EX Series Credit Source with PaperCut 

RSX1000 
Release Station/PayStation 

EX Series Payment Devices 

 

6 | P a g e  
Copyright 2015 ACDI – Access Control Devices, Inc. 

releases-on This option applies to installations using Find Me Printing and sets the behavior of jobs released 
from a virtual queue. For more information see Chapter 14, Find Me Printing and Printer Load 
Balancing. 

This setting defines the printer (or list of printers) that the jobs should be printed to when 
released. This is usually the printer(s) in close proximity to this release station. 

confirm-printing When enabled (Y) and users release a job that is charged to their personal account, a 
confirmation dialog is displayed to confirm that the user wants to print and be charged for the 
job. When disabled (N) the confirmation dialog is never displayed. 

display-columns Used to customize the columns displayed and the order they appear in the list of print jobs. The 
default value is: date,user,printer,document,machine,pages,cost 

display-column-
widths 

Used to customize the width of columns displayed. The setting can only be used if the display-
columns is defined. The number of values must match the number of values in the display-
columns setting. The default value is: 8,12,25,30,15,8,8 

hide-printer-
server-names 

(Y/N) - Used to hide the printer server names from the list of print jobs. Default: N (No) 

show-print-all (Y/N) - Indicates whether the Print All button should be displayed. Default: Y (Yes) 

show-cancel-all (Y/N) - Indicates whether the Cancel All button should be displayed. Default: Y (Yes) 

max-idle-secs The number of seconds without user input, before the user is logged out of the release station. 
The default is 30 seconds. 

background-color Allows for customizing the background color of the release station to match the organization's 
colors. The color format is the hexadecimal color code used in HTML - #RRGGBB (where RR is the 
red component, GG is the green component and BB is the blue component). 

font-color Allows for customizing the font/foreground color used in the release station. The color format is 
the hexadecimal color code used in HTML. 

locale Allows to override the default language used for the release station. The value is a valid ISO 
language code. E.g. en, zh_HK. 

title The title that appears at the top of the release station screen. 

instructions The instructions to display at the login page. A <br> can be included to start a new line. 

card-and-
username-
instructions 

The instruction text that appears when using both card authentication and username 
authentication, appearing in-between the card entry and username entry fields. A <br> can be 
included to start a new line. 

username-label Override the label text for the Username field. 

password-label Override the label text for the Password field. 

logo-image Allows a custom logo image to be displayed. For best results the image should be between 50 
and 80 pixels in height. PNG, JPG or GIF images are allowed. 

scale-factor Allows adjustment of text displayed in the release station. Higher value increases the text size. 
Larger text may be preferable on high resolution screens or touch screens. The default is 1.5. 

release-cancel-
gui-style 

Allows to set the GUI style of the release station actions. The valid styles are link and button. 
Setting it to button is useful when running release station on touch screens. The default is link. 

enable-card-self-
association 

(Y/N) - Enable or disable card self-association. This allows users to associate their card with their 
account without needing any administrator assistance. Default: N (No) 

enable-on-screen-
keyboard 

(Y/N) - Enable or disable the on-screen (software) keyboard. Use of the on-screen keyboard is 
recommended for touch-screen devices. Supported on Microsoft Windows only, via the on-
screen keyboard utility (osk.exe) or an alternate application. Default: N (No) 

http://www.papercut.com/products/ng/manual/ch-find-me-printing-and-load-balancing.html
http://www.papercut.com/products/ng/manual/ch-find-me-printing-and-load-balancing.html
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on-screen-
keyboard-path 

Specify an alternate on-screen keyboard application to the Microsoft Windows default. 
Supported on Microsoft Windows only. Default: (none) 

Table 1.1 Standard Release Station configuration settings 

Tip 

When running release stations with Payment Hardware devices it is recommended that the working directory for the 

release station be copied from the \\server\PCRelease share to each Release Station PC.  This allows specific settings like 

COM port for each implementation.  Often placing this folder in the root of C: works well.  

Release Station Modes 
The release station modes available are described below. The release station mode is changed in the configuration file 

as described in the section called “Standard Release Station Configuration”. 

Mode Description 

ReleaseAny This is the default mode. It allows a user who logs onto the release station to release any held jobs. Any jobs released will be 

charged to the logged in user. 

Manager Manager mode allows only administrators or hold/release queue managers to log in to the release station. In release station mode, 

all jobs are listed and users are not automatically logged out due to inactivity. 

Secure Secure mode allows users to only see and release print jobs that they have printed. Release station managers can see and release 

all users' print jobs. 

NoPassword This works similar to the secure mode, however users don't need to enter the password to view jobs. 

Table 1.2 Standard Release Station modes 

In all modes except Manager Mode, users are logged out automatically after a period of inactivity defined in the 

configuration file, the default being 30 seconds. 

Card-based User Authentication 
In some environments, users are issued with identity cards that can be used for authentication. The cards might be used 

to gain entry to buildings, or borrow from a library. The cards can also be used to authenticate users at the standard 

release station. Using a card is often much more convenient and less error-prone than entering a username and 

password. 

To use card-based authentication an appropriate hardware card-reader is required. The card reader must be connected 

to the machine running the release station and act like a keyboard. i.e. when the user swipes/scans their card, the card 

reader outputs the digits just as if someone entered them using the keyboard. There are card readers that can do this 

for all commonly used card types (e.g. magnetic stripe, barcode, etc). An easy way to test a card reader is to open a text 

editor and place the cursor in a new text document. Then when a card is swiped the card number will appear in the text 

file. 

The card numbers entered at the release station are validated against the Card/Id number field for the user. This can be 

found at the bottom of the user details screen in the admin interface. Before card authentication can be used, the users' 

card numbers must be associated with the user record in PaperCut NG. The numbers can be entered manually, 

automatically synchronized from Active Directory or LDAP (see the section called “Card/Identity Numbers Sync”) or 

imported in bulk using the Batch User Import file (see the section called “Batch User Data Import and Update”). 

http://www.papercut.com/products/ng/manual/rs-conf.html#rs-conf-software
http://www.papercut.com/products/ng/manual/ch-sys-mgmt-user-group-sync.html#ch-sys-mgmt-user-imp-card-id
http://www.papercut.com/products/ng/manual/ch-user-mgmt-import-update.html
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Once card numbers are associated with users, the card-based authentication can be enabled in the release station by 

setting the use-card-authentication to Y in the release station's config.properties file. Once the release 

station is restarted it will be in card-authentication mode, and can be tested by swiping a card through the card-reader. 

Alternatively, card numbers may be self-associated by users at the release station. Enable this functionality by 

setting enable-card-self-association to Y. Note that this also requires use-card-authentication to 

be enabled as well. 

The config.properties file has some other settings to change how the card-number is read from the reader. For 

example, you can change the header and trailer characters used by some card readers to indicate the start and end of 

the card number. See the config file for details. 

Friendly client machine aliases 
In some environments (for example public libraries), it can be important for users to identify print jobs by the client 

machine they were printed from. By default, the release station will list the either the IP address or the machine's 

unique network name neither of these are helpful to release station users. To avoid this problem the administrator can 

define a list of aliases that map the unfriendly names to a more user-friendly name. 

For example, print jobs might appear in the release station as 192.168.1.100 or winpc0076, but would be more 

meaningful for the user to appear as Public PC 1. 

These aliases are defined in the [app-path]/release/client-machine-aliases.properties file. The 

entries are in the format: 

        [machine]=[alias] 

It is also valid to have multiple entries that map to the same alias. So to add aliases for the example above the 

following lines would be added to the client-machine-aliases.properties file: 

        192.168.1.100=Public PC 1 

        winpc0076=Public PC 1 

Job timeout 
If a user does not release their held job after a defined time, their job will be automatically deleted. This is to prevent a 

buildup of old/abandoned jobs in the hold/release queue. The default timeout is 30 minutes, and can be changed as 

follows: 

1. Navigate to Options → General → Hold/Release Queues and find the option Delete held jobs if not released 

after. 

2. Enter the number of minutes to wait for users to release their job before it is deleted. 

3. Press Apply 
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End-User Web Based Release Interface Configuration 
Configuration options for the end-user web based release interface can be found in the administrative interface 

at Options → General → User Features. These options control the availability of the Jobs Pending Release option 

available to end users. The available options are: 

 
Figure 13.9. End-user web based release interface options 

 Allow users to view held jobs - this option enables the Jobs Pending Release screen in the user web tools. When 

this option is disabled, no related functionality is available from the user web tools interface. 

 Users have permission to: - this option changes which type of jobs users can see and/or release. The available 

options are: 

o view their own jobs only - users may see their own jobs that are held in the hold/release queue. Jobs 

printed by other users are not displayed. They may cancel their own jobs, but cannot release them. This 

is useful if users are required to be physically at the printer to release a job, where a standard release 

station is running. 

o release their own jobs - users may release or cancel their own jobs. Jobs printed by other users are not 

displayed. 

o release any jobs (charged to their account) - users may release or cancel any job that is being held, 

including jobs from other users. If a user releases a job that was sent by a different user, the releasing 

user is charged for the job. This option is equivalent to the Release Any mode used in Release Station 

and is ideal for authenticating printing in a unauthenticated environment. 

 Enable the 'Release All' and 'Cancel All' buttons - enabling this option allows users to release or cancel all held 

jobs by clicking one button. When this option is disabled, users must release or cancel jobs individually. 

This option is purely for the convenience of the users. It can save a user a few clicks when they want to release 

all their jobs at once. However if the user is able to release jobs other than their own, a user might accidentally 

release (and be charged for) many other users' job 
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Credit Source Configuration and Setup  
While each device comes with a separate document for setup and device specific configuration, there are several 
configuration options that apply to all credit sources.  
The configuration files of interest are:  
• [app-path]/release/config.properties, which provides global configuration options for the station.  
• [app-path]/release/extensions/pay-and-release.properties, with options specific to pay and release 
mode.  
• [app-path]/release/extensions/pay-station.properties, with options specific to pay station mode.  
• [app-path]/release/extensions/credit-sources/*, where you will find several configuration files specific 
to the type of device that will be connected.  

Display Instructions  
The station can display a short message on screen that instructs the user about how to use the payment device. The 

instructions can be used to guide the user through the process of adding to their account balance as well as providing 

any organization specific information (such as the places their balance may be used). The instructions option is available 

in most of the config files. Setting the option in more specific config files will override the option in less specific ones.  

Station Name  
By default the station will be listed on the Devices tab of the PaperCut administration interface with the name pay-

station-hostname, where hostname is the host name of the system where the pay station is running.  This name may be 

changed by editing the pay station or pay and release configuration file and setting a value for the station-name option.  

Visual Customization  
The pay station may be visually customized in the same way as the release station. See the PaperCut user manual 

section Hold/Release Queues & Print Release Stations → Release Station Configuration → Standard Release Station 

Configuration for further information.  

Account Charge Order  
The account-charge-order option in the pay and release configuration file determines which source of credit is charged 

first. Currently the two options are the user’s personal account balance and the credit source’s balance.  

Providing Change  
The give-change option determines what happens to the remaining balance when a user logs out. The device specific 

setup guides will provide a recommendation on the option to use.  For more information see the comments in the config 

file.  

Balance Labels  
The personal-balance-label and credit-source-balance-label options can be used to append text after the displayed 

balances. E.g. “$1.00 (card)“ instead of just “$1.00”. This can be useful if users are confused about which balance is 

which.   
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EX Series Payment Hardware 
Payment integration may be provided in one of two possible modes: pay station mode, or pay and release mode. Pay 

station mode is designed for devices such as bill acceptors where a payment can be made but no change can be 

returned. Payments are made directly into a user’s account, which can then be used for printing. A station can be run in 

dedicated pay station mode so that the station is used for payments only (and has no association with print job release), 

also known as a kiosk type system. Pay and release mode is designed for devices that can provide change or store a 

balance, such as a cash acceptor with coin return, or a stored value card reader. The cost of held print jobs is charged to 

the device as they are released. The remaining amount can then be returned to the user as change or left on their card 

when the user logs out.  

Hardware Configuration and Setup 
This section covers the setup and configuration of an external ACDI Payment Source with a PaperCut Release Station or 
PayStation Setup. 

Hardware Requirements 
The following is a list of hardware this guide assumes will be available. All hardware is available from ACDI or an 
authorized ACDI reseller.  Several hardware devices have the option to be used in conjunction as a walkup copy 
payment source. 

 EX2000(Coin Only), EX2000B(Coin and Bills), EX2000BC(Coin, Bill, and Stored Value Card) 

 ACD3000(Stored Value Card) 

 TheSwiper(Standalone Credit Card Terminal), EX2000CCB(Coin, Bill, and Credit Card) 

 PC Connect Cable(USB interface)  

 RSX1000 Kiosk or a stand-alone computer with a display for running the pay station/release station 
software  

Installing the Device 
To connect the ACDI PC Connect interface to the computer the instructions present with the PC Connect cable should be 

used. On Windows platforms, this would typically involve the following:  

1. Connect the DB9 pin connector into the “Data 1” port located on the side (coin-ops) or rear(card reader/swiper). 

2. IMPORTANT:  For simplest setup, install usb drivers before connecting usb cable to pc. 

3. Drivers are included on a CD that comes with the PC Connect Cable or can be downloaded from Prolifc or FTDI. 

4. Connect the USB cable to usb port on pc. (Typically a rear port is used 

to minimize patron disconnects). 

5. Windows will detect device and automatically configure drivers. 

6. Open Device manager and confirm that the device is listed under 

ports.  

7. Note the Com Port number. (this will be needed to configure 

communication with the device) 
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Installing the Plug-In 
ACDI has developed a plugin that allows the PaperCut release station to be extended to support the EX series of 

Payment hardware.  This is delivered via a zipped folder that can be found at 

http://acdirewards.com/downloads/ACDI_EX_Series_PaperCut_Plugin.zip 

This folder contains the folder structure to copy directly into the release station folder. This will place all of the needed 

files in their proper location. 

The file locations are provided below for reference: 

 [app-path]/release/extensions/pay-station.properties 

 [app-path]/release/extensions/pay-and-release.properties 

 [app-path]/release/extensions/ACDI_EX_Series_Pay_Release.properties 

 [app-path]/release/extensions/ACDI_EX_Series_PayStationMode.properties 

 [app-path]/release/lib-ext/ACDIEXCreditSource.jar 

Enabling the Device 
To enable the device in Pay and Release mode: 

 Locate  [app-path]/release/extensions/pay-and-release.properties 

 Set enabled option equal to enabled=Y. 

 Set credit source option equal to credit-source=ACDI_EX_Series_Pay_Release 

To enable the device in PayStation mode: 

 Locate  [app-path]/release/extensions/pay-station.properties 

 Set enabled option equal to enabled=Y. 

 Set credit source option equal to credit-source=ACDI_EX_Series_PayStationMode 

  

http://acdirewards.com/downloads/ACDI_EX_Series_PaperCut_Plugin.zip
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Configuring the Device 
The configuration files must first be copied into the release station credit-sources directory.  This directory is located at 

[app-path]/release/extensions/credit-sources/. 

 Copy the ACDI_EX_Series_Pay_Release.properties file into the above directory for ACDI device specific 

Pay and Release mode configuration. 

  Copy the ACDI_EX_Series_PayStationMode.properties file into the above directory for ACDI device 

specific PayStation mode configuration. 

Pay and Release 

1. Open the file [app-path]/release/extensions/credit-

sources/ACDI_EX_Series_Pay_Release.properties in a text editor.  

2. Update the value for the option comm-port= to match the correct port, e.g.: comm-port=COM1 (value 

should match com port listed in device manager.) 

3. Update the value for the option copier-controller-enabled= to indicate if the device will be used in 

conjunction as a copier controller for walk-up copier usage. E.g.: copier-controller-enabled=Y 

4. Update the value for the option can-give-change= to match capabilities of the attached ACDI EX Series 

payment hardware. e.g.: can-give-change=Y 

5. The configuration file also includes several displayed text settings.  This allows for extensive customization 

of screen prompts to better communicate with patrons. 

 

PayStation 

1. Open the file [app-path]/release/extensions/credit-

sources/ACDI_EX_Series_PayStationMode.properties in a text editor.  

2. Update the value for the option comm-port= to match the correct port, e.g.: comm-port=COM1 (value 

should match com port listed in device manager.) 

3. Update the value for the option copier-controller-enabled= to indicate if the device will be used in 

conjunction as a copier controller for walk-up copier usage. E.g.: copier-controller-enabled=Y 

4. Update the value for the option partial-account-add= to allow only a portion of available escrow to be 

selected for applying to the users account. e.g.:partial-account-add=Y 

5. The configuration file also includes several displayed text settings.  This allows for extensive customization 

of screen prompts to better communicate with patrons. 
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Testing 

Pay and Release 
To test that the device has been configured correctly:  

1. Start the release station (e.g. on Windows run pc-release.exe).  

2. Send some print jobs so that they hold in a hold/release queue.  

3. Log into the station as the user who sent the job. Note that the user must be marked as restricted in PaperCut (it 

doesn’t make sense for unrestricted users to make payments).  

4. Insert some coins / bills /stored value card etc. Ensure that the release station GUI is updated and displays the 

available amount (the same amount displayed on the device’s LCD).  

5. Release some jobs to ensure that they are charged correctly and that the available amount is updated. Note that 

the account-charge-order setting may specify that the user’s personal account is charged before taking the 

amount from the device.  

6. Try logging out while there is balance remaining in the session to ensure that change is returned correctly.  

Experiment with the options account-charge-order and give-change in the configuration file pay-and-

release.properties. Remember to restart the release station after making a change. This is often a good time to 

tweak the other settings and configurable messages.  

Pay Station Mode 
To test that the device has been configured correctly:  

1. Start the PayStation (e.g. on Windows run pc-paystation.exe or log into the release station and press the 

'Add Value' button.) 

1. The device should now be enabled for acceptance of funds. 

2. Insert one of each type of funds accepted by the device (example: coin, bill, stored value card, credit card, etc.) 

3. Make sure that balance on screen increments by the correct value. 

4. If partial balance apply is turned on, make sure the balance selected is added to the account balance. 
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Suggested Cash Collection Procedure  
When dealing with devices that collect cash it is essential that the organization has a well-defined procedure for its 
collection and auditing. We suggest using the following procedure to collect cash from a device.  

Requirements  
 One person is designated 'collector', and will be responsible for collecting the cash from the device, counting it and 

returning it to the office / cash storage location.  

 The collector has access to a network login designated specifically for collecting cash (i.e. it should not be an account 

that is otherwise used for printing, copying or adding balance).  

 A second person is designated 'approver', and will be responsible for cross-checking the collector's cash takings, 

depositing the cash and filing the cash reconciliation report.  

Process  
The collector should:  

1. Log into the Pay Station using their designated account and deposit $1. This transaction will mark the end of the 

collection period for this device.  

2. Collect the cash from the device and set it up again so that it may be used immediately.  

3. Log into the PaperCut administration interface, either from the Pay Station itself or from another convenient 

system.  

4. Navigate to Devices → [name of device] → Transaction History, and click Show Filter.  

5. In the Transacted by field, enter their designated user name, remove the date under From date and press Apply 

Filter. The table will now show all transactions on this device from the collector.  

6. Identify the date and time of the last transaction. This will be the transaction from step #1. This date and time 

should be entered into the To date and corresponding Time field.  

7. Identify the date and time of the second-last transaction. This should be the collector's transaction from the 

previous collection period. The date and time should be entered into the From date and corresponding Time 

field. The time entered should be one second after this transaction so that it is not included in the data for this 

collection period.  

8. Clear the Transacted by field and press Apply Filter. The table should now display all transactions after the 

previous collection, and up to and including the transaction from step #1.  

9. Below the table, click Reconciliation report. Print the generated report.  

10. Count the collected cash and fill in the printed report, including the amount collected and how much (if any) it 

differs from the reported amount.  

11. Take the cash and signed report to the approver for cross-checking and sign-off.  

After counting the cash and signing the report, the approver should:  
• Deposit the cash and file the signed report.  
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Modifications to Cash Collection Procedure  
Some possible modifications to the above cash collection procedure include:  

• If you have an accurate time source (such as a server's clock, or if workstations have their time reliably updated via 

NTP / “time synchronization”) then there is no need to make the $1 deposits to mark the time. The collector would 

simply skip this step and type the accurate time directly into the Transaction History filter.  

• For extra security you may prefer that a person other than the collector runs the reconciliation report. This ensures 

that the collector does not know whether there is more cash in the device than has been reported, so is unable to take 

advantage of the situation.  

Troubleshooting and Investigating Overs / Unders  
Differences between cash collected and recorded amounts taken (overs or unders) are possible or even common in any 

environment where manual cash handling or processes take place. Significant overs or unders may warrant further 

investigation.  

Because overs or unders are common it is important that there is a well defined procedure to follow. As the situation is 

similar to collecting cash from other devices such as cash registers, vending machines or coin units, the organization may 

have an existing process which can be adapted.  

Detailed transaction and operational information can be gathered from PaperCut and the Pay Station as follows:  

• A full transaction history for the device can be accessed from the PaperCut administration interface, via Devices → 

[name of device] → Transaction History. The filters provided make it easy to narrow down the search to a particular time 

period or for a particular user.  

• Event and transaction logs are also stored on the Pay Station system itself. These are located in the home directory of 

the user currently logged into the operating system, e.g. C:\Documents and Settings\username. The Pay Station 

maintains the following files in this directory:  

• pay-station-transaction.log – contains all transactions carried out on the device. It should match the device's 

transaction history in the administration interface (mentioned above).  

• pay-station-event.log – contains various information about the state of the Pay Station. If there has been an error 

processing a transaction it will be logged here.  

• release-station.log – contains more general information about the running of the Release Station and Pay Station 

functionality. If a serious error has occurred while running the Pay Station it will be logged here.  

 

  



Setup  of EX Series Credit Source with PaperCut 

RSX1000 
Release Station/PayStation 

EX Series Payment Devices 

 

17 | P a g e  
Copyright 2015 ACDI – Access Control Devices, Inc. 

Appendix A – Kiosk Mode Lock Down 
This guide covers Windows 7 and Windows 8 Professional editions. Ensure that the release station PC is running a 

professional edition of Windows. Following this guide, the PaperCut release station and paystation software will be 

more secure and user friendly for walk-up users. 

Setup  
 

 Create a local user with the desired privileges under computer management ;  

 As an admin account, run the Microsoft Management Console (mmc.exe);  

 Go to File > Add/Remove Snap In...  

 Select the Group Policy Object and press Add  

 Press the Browse... button  

 In the Users tab, select the user you just created  

 Press finish  

 Go to User Configuration > Administrative Templates > System and edit the Custom User Interface settings  

 Change it to Enabled and enter your application path (i.e "C:\<Dir Location>\pcrelease.exe") in the Interface File 

Name field. 

Next time you log in using this user, Windows won't load Explorer.exe, but your application instead. This way you won't 

have easy access to the desktop.
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